The LyX Tutorial

by the LyX Team\(^1\)

December 2, 2016

\(^1\)If you have comments on or corrections to this documentation, please send them to the LyX Documentation mailing list: lyx-docs@lists.lyx.org
# Contents

1 Introduction 5
   1.1 Welcome to LyX! 5
   1.2 What the Tutorial *is* and what it *is not* 5
       1.2.1 Getting the most out of the Tutorial 6
       1.2.2 What you *will not* find 6

2 Getting started with LyX 7
   2.1 Your first LyX document 7
       2.1.1 Typing, Viewing, and Exporting 8
       2.1.2 Simple Operations 9
       2.1.3 WYSIWYM: Whitespace in LyX 10
   2.2 Environments 10
       2.2.1 Sections and Subsections 11
       2.2.2 Lists and sublists 13
       2.2.3 Other environments: Verses, Quotations, and more 14

3 Writing Documents 15
   3.1 Document Classes 15
   3.2 Templates: Writing a Letter 16
   3.3 Document Titles 18
   3.4 Labels and Cross-References 18
       3.4.1 Your first label 18
       3.4.2 Your first cross-reference 19
       3.4.3 More fun with labels 19
   3.5 Footnotes and Margin Notes 20
   3.6 Bibliographies 21
   3.7 Table of Contents 22
## CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Using Math</td>
<td></td>
</tr>
<tr>
<td>4.1</td>
<td>Math Mode</td>
<td>25</td>
</tr>
<tr>
<td>4.2</td>
<td>Navigating an Equation</td>
<td>26</td>
</tr>
<tr>
<td>4.3</td>
<td>Exponents and Indices</td>
<td>27</td>
</tr>
<tr>
<td>4.4</td>
<td>The Math toolbar</td>
<td>27</td>
</tr>
<tr>
<td>4.4.1</td>
<td>Greek and symbols</td>
<td>28</td>
</tr>
<tr>
<td>4.4.2</td>
<td>Roots, decorations, and delimiters</td>
<td>28</td>
</tr>
<tr>
<td>4.4.3</td>
<td>Fractions</td>
<td>29</td>
</tr>
<tr>
<td>4.4.4</td>
<td>Functions: ( \lim, \log, \sin ) and others</td>
<td>29</td>
</tr>
<tr>
<td>4.4.5</td>
<td>Matrices</td>
<td>29</td>
</tr>
<tr>
<td>4.4.6</td>
<td>Display mode</td>
<td>30</td>
</tr>
<tr>
<td>4.5</td>
<td>More Math Stuff</td>
<td>31</td>
</tr>
<tr>
<td>5</td>
<td>Miscellaneous</td>
<td></td>
</tr>
<tr>
<td>5.1</td>
<td>Other major \LaTeX{} Features</td>
<td>33</td>
</tr>
<tr>
<td>5.2</td>
<td>\LaTeX{} for \LaTeX{} Users</td>
<td></td>
</tr>
<tr>
<td>5.2.1</td>
<td>\TeX{} Mode</td>
<td>34</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Importing \LaTeX{} Documents — \text2lyx</td>
<td>35</td>
</tr>
<tr>
<td>5.2.3</td>
<td>Converting \LaTeX{} Documents to \LaTeX{}</td>
<td>36</td>
</tr>
<tr>
<td>5.2.4</td>
<td>\LaTeX{} Preamble</td>
<td>36</td>
</tr>
<tr>
<td>5.2.5</td>
<td>Bib\TeX{}</td>
<td>37</td>
</tr>
<tr>
<td>5.3</td>
<td>Errors!</td>
<td>37</td>
</tr>
</tbody>
</table>
Chapter 1

Introduction

1.1 Welcome to LyX!

This manual is designed for all of you who have never heard of \LaTeX, or do not know it very well. Now, do not panic – you will not need to learn \LaTeX{} to use LyX. That is, after all, the whole point of LyX: to provide an almost-WYSIWYG interface to \LaTeX{}. There are some things you will need to learn, however, in order to use LyX effectively.

Some of you probably found your way to this document because you tried to put two spaces after a “.” or tried to put three blank lines between paragraphs. You found out you could not and, in fact, you will find out that most of the little tricks you are accustomed to use in word processors will not work in LyX. That is because most word processors you have used before allow you manually to enter all spacings, font changes, and so on. So you end up not only writing a document but typesetting it, too. LyX does the typesetting for you, in a consistent fashion, letting you focus on the important things, like the content of your writing.

So read on to learn more about LyX. Reading this tutorial is definitely worth the time.

1.2 What the Tutorial is and what it is not

Before we get started with this section, you need to know that this Tutorial uses the notation outlined in the Introduction manual. If you came to
CHAPTER 1. INTRODUCTION

this manual first, please read the Introduction before you continue with the Tutorial.

Now that you know which fonts mean what in the documentation, we want to talk a bit about what this Tutorial is for.

1.2.1 Getting the most out of the Tutorial

This tutorial consists of examples and exercises. To get the most out of this document, you should read through it, typing all the little things we are telling you to type and trying out all of the exercises to see if you get them right. For convenience, you might want to print out the PDF version of this document.

If you are familiar with \LaTeX, you will probably be able to read the Tutorial somewhat faster, since many LyX ideas are just \LaTeX ideas in disguise. However, LyX has features you will want to learn about. Even if you do not feel like reading the rest of the Tutorial, you should definitely check out Section 5.2, which is specifically written for experienced \LaTeX users.

1.2.2 What you will not find

- Detailed explanations of all of LyX’s features.
  Look in the User’s Guide when you need this.

- Detailed explanations of \LaTeX.
  Unnecessary. If you want to learn some of the neat tricks you can do with \LaTeX in LyX, you can have a look at the Embedded Objects manual.

It is time to move on, time for your first document …
Chapter 2

Getting started with LyX

2.1 Your first LyX document

OK. You are ready to start writing. Before you do, there are a few things we need to mention, which will hopefully make the Tutorial more instructive and useful.

Because there is information we cannot give you in the Tutorial, the first thing that you need to do is find the other help files. This is very simple: Start up LyX, select the User’s Guide from the Help menu. You may want to load the Tutorial as well (if you are not reading it within LyX already). This way, you can read them while you are writing your own file.¹ Note that once you have got more than one document open, you can use the View menu or the document tabs to switch between them.

In this Tutorial, we are going to assume that you have a fully working version of LyX, as well as a LaTeX-distribution and a PDF-viewer. This should be the case on all major Linux- and BSD-distributions, as well as on Windows, where this is setup by the LyX installers.

Finally, we have written a file called example_raw.lyx to let you practice your LyX skills. Imagine that it was typed by someone who did not know about any of LyX’s great features. As you learn new LyX functions, we will suggest that you fix those parts of example_raw.lyx. It also contains ‘subtle’ hints about how to fix things.² If you want to cheat, or check what you have done, there is also a file called

¹They can also serve as good examples of how to use the many features of LyX.
²The hints are located in yellow “Notes”. Access the text in a note by clicking on it.
example_lyxified.lyx which contains the same text written and type-
set by a LyX master.

The example files can be found in the examples directory of LyX’s
installation folder. Open the document example_raw.lyx and use File ⊿
Save As to save a copy in your own directory for you to work on. As you
fix parts of the raw document, check to see how those changes affect the
output.

By the way, the examples directory contains lots of other examples
files. They will show you how to do various fancy things with LyX. After
you have read the Tutorial, or when you are confused about how to do
something fancy in LyX, take a look at these files.

2.1.1 Typing, Viewing, and Exporting

• Open a new file with File ⊿ New

• Type a sentence like: This is my first LyX document!

• Save your document with File ⊿ Save As.

• Create a PDF file, with Document ⊿ View or the toolbar button ☋.
LyX will open a PDF-viewer program displaying your document as
it will look when printed.

• Export the ready to print document with File ⊿ Export to a format
you want.

Congratulations! You have written your first LyX document. All of the rest
is just details.

A hint: You can save time by leaving the PDF viewer running in the
background. Under MacOS and Linux you can use Document ⊿ Update or
the toolbar button ☋ and just click on the PDF viewer window afterwards.
Under Windows still use Document ⊿ View or ☋ respectively.

Another hint: In case you are using a high-resolution display, the LyX
toolbar icons are quite small. To change their size, right-click into a toolbar.
2.1. YOUR FIRST LyX DOCUMENT

2.1.2 Simple Operations

LyX can of course do most of the things you are used to doing with a word processor. It will word-wrap and indent paragraphs automatically. Here is a quick description of how to do some simple actions.

**Undo**  LyX has multiple levels of undo, which means you can undo everything you have done since your current editing session started, by selecting Edit ⊳ Undo (toolbar button 🔄) over and over again. If you undo too much, just select Edit ⊳ Redo (toolbar button 🔄) to get it back.

Currently, undo is limited to 100 steps.

**Cut/Paste/Copy**  Use Edit ⊳ Cut (toolbar button 🪔), Edit ⊳ Copy (toolbar button 🖋), and Edit ⊳ Paste (toolbar button 📝) to cut, copy, and paste. Or automatically paste selected text (including selections from other programs) with the *middle mouse button*.

**Find/Replace**  Use Edit ⊳ Find & Replace (toolbar button 📒) to search. In the dialog, search with the Find Next button, and use the Replace button to replace a word you have found.\(^3\) If you like, you can specify whether to make the search case-sensitive, or to search for only complete words; you can also search backwards through the document.

**Character Formatting**  You can *emphasize* text (toolbar button 🎨, which will by default print characters in italics), set it in NOUN STYLE (toolbar button 🆝, usually small caps, used for people’s names), or use your own formatting by using the Edit ⊳ Text Style ⊳ Customized dialog (toolbar button 📷).

**Toolbar**  Other buttons on the toolbar allow you to do some of the more popular functions, such as Insert math, Insert graphics and Insert table.

Of course, you have not yet written enough to make most of these functions useful. As you write more, though, try undoing, pasting, etc.

\(^3\)Close the window when you are done or leave it open if you find it more convenient. Most dialog boxes in LyX can operate like this. Just be sure you have the right window in focus when you are trying to type in the main LyX window or a LyX dialog.
2.1.3 WYSIWYM: Whitespace in LyX

One of the hardest things for new users to get used to is the way that LyX handles whitespace. As many times as you hit Return, you will only get one blank line. As many times as you hit Space, you will only get one space. On a blank line, LyX will not let you type even one space. The Tab key will not move you forward one tab stop; in fact there are no tab stops! There is no ruler at the top of the page to let you set tabs or margins, either.

Many word processors are based on the WYSIWYG principle: “What You See Is What You Get.” LyX, on the other hand, is based on the principle that “What You See Is What You Mean.” You type what you mean and LyX will take care of typesetting it for you so that the output looks nice. A Return grammatically separates paragraphs and a Space grammatically separates words; so there is no reason to have several of them in a row; a Tab has no grammatical function at all – so LyX does not support it. Using LyX, you will spend more of your time worrying about the content of your document and less time worrying about the format. See the Introduction for more information on the WYSIWYM concept.

LyX does have (many) ways to fine-tune the formatting of your document. After all, LyX might not typeset exactly what you mean. The User’s Guide has information about all that. It includes horizontal fills and vertical space — which are more powerful and versatile than multiple spaces or blank lines — and ways to change font sizes, character styles, and paragraph alignments by hand. The idea, though, is that you can write your whole document, focusing on content, and just worry about that fine-tuning at the end. With standard word processors, you will be distracted by document formatting throughout the writing process.

2.2 Environments

Different parts of a document have different purposes; we call these parts environments. Most of a document is made up of regular text. Section titles (chapter, subsection, etc.) let the reader know that a new topic or subtopic will be discussed. Certain types of documents have special environments. A journal article will have an abstract and a title. A letter will have neither of these, but will probably have an environment that gives the writer’s address.
2.2. ENVIRONMENTS

Environments are a major part of the “What You See Is What You Mean” philosophy of LyX. A given environment may require a certain font style, font size, indenting, line spacing, and more. This problem is aggravated, because the exact formatting for a given environment may change: one journal may use boldface, 18 point, centered type for section titles while another uses italicized, 15 point, left justified type; different languages may have different standards for indenting; and bibliography formats can vary widely. LyX lets you avoid learning all the different formatting styles.

The Environment choice box is located on the left end of the toolbar and looks like this: $\text{Standard}$. It indicates in which environment you are currently writing. While you were writing your first document, it said “Standard,” which is the default environment for text. Now you will put a number of environments in your new document so that you can see how they work.

2.2.1 Sections and Subsections

Type the word Introduction on the first line of your new LyX file, and select Section in the Environment box.\(^4\) Be sure to use Section and not Section*, which will be covered below. LyX numbers the section “1” and typesets the section heading (title) in a larger font. Now hit Return. Note that the Environment box changes from “Section” back to “Standard”. Section headings, like most environments, are assumed to end when you type Return. Type the document introduction:

This is an introduction to my first LyX document.

Hit Return again, and select Section from the Environment box again. LyX writes a “2” and waits for you to type a title. Type “More Stuff”, and you will see that LyX again sets it as a section title.

It gets better. Go to the end of Section 1 again (after “my first LyX document.”) and hit Return again, and select Section from the Environment box again. Again, LyX writes “2” and waits for you to type a title. Type About This Document. Section “More Stuff”, which was Section 2, has

\(^4\)You do not have to select the line. If nothing is selected, LyX changes the paragraph you are currently in to the selected environment. Alternatively, you can change several paragraphs to a different environment by selecting them before picking an environment.
been automatically renumbered to Section 3! In true WYSIWYM fashion, you just need to identify the text that makes up the section titles, and LyX takes care of numbering the sections and typesetting them.

Hit Return to get back to the Standard environment, and type the following five lines:

Sections and subsections are described below.
Section Description
Sections are bigger than subsections.
Subsection description
Subsections are smaller than sections.

Click on the second line and select Subsection from the Environment box. LyX numbers the subsection “2.1”, and typesets it in a font which is bigger than regular text but smaller than the section title. Change the fourth line to the Subsection environment as well. As you probably expected, LyX automatically numbered the section “2.2”. If you put yet another section before Section 2, Section 2 will be renumbered as Section 3, and the subsections will be renumbered to “3.1” and “3.2”.

Further levels of sectioning include Subsubsection, Paragraph, and Subparagraph. We will let you play with these on your own. You may notice that paragraph and subparagraph headings are not numbered by default, and that subparagraphs are indented; see the User’s Guide for an explanation and how to change this. Chapter headings are actually the highest level of sectioning, above Sections, but you are only allowed to use them in certain types (text classes) of LyX documents (see Section 3.1).

Finally, you may want to have sections or subsections that are not numbered. There are environments for this as well. If you change one of your section headings to the Section* environment (you may have to scroll down in the Environment box to find it), LyX will use the same font size for the heading as it uses for a regular section, but it will not number that section. There are corresponding “starred” heading environments for Subsection and Subsubsection. Try changing some of your sections or subsections to the starred environments, and note how the other section numbers are updated.

Exercise: Fix the section and subsection headings in example_raw.lyx.
2.2.2 Lists and sublists

\textit{LYX} has several different environments for typesetting lists. The various list environments free you from hitting \textit{Tab} a million times when writing an outline, or from renumbering a whole list when you want to add a point in the middle of the list. Different types of documents logically require different list environments:

- A slide presentation might use the \texttt{Itemize} environment’s bulleted lists to describe different points.

- An outline would use the \texttt{Enumerate} environment’s numbered lists (and lettered sublists).

- A document describing several software packages could use the \texttt{Description} environment, where each item in the list begins with a bold-faced word.

- The \texttt{List} (also named \texttt{Labeling}) environment is a variation on the \texttt{Description} environment.

Let us write a list of reasons why \textit{LYX} is better than other word processors. Somewhere in your document, type:

\begin{verbatim}
LYX is better than other word processors because:
and hit Return. Now select \texttt{Itemize} from the Environment box (\texttt{\textbackslash I}). \textit{LYX} writes a “bullet” on the line. Type in your reasons:
\end{verbatim}

\begin{verbatim}
Typesetting is done for you.
Math is WYSIWYG
Lists are very easy to create!
\end{verbatim}

List environments, unlike headings, do not end when you type \texttt{Return}. Instead, \textit{LYX} assumes you are going on to the next item in the list. The above will therefore result in a three-item list. If you want more than one paragraph within one list \texttt{item}, one way is to use the \texttt{Protected Break}, which you get by typing \texttt{Ctrl+Return}. In order to get out of the list, you need to reselect the \texttt{Standard} environment (or just use the key binding \texttt{Alt+A S}).

You now have a beautiful itemized list. You might want to run \texttt{LATEX} to see how the list looks when printed out. But what if you wanted to number
the reasons? Well, just select the whole list\(^5\) and choose Enumerate from the Environment box (≡). Pow! As we mentioned, if you add or delete a list item, LyX will fix the numbering.

While the list is still selected, you can change to the other two list environments, Description and List / Labeling (≡ and ≡), in order to see what they look like. For those two environments, each list item is made up of a term, which is the item’s first word, followed by a definition, which is the rest of the paragraph (until you hit Return). The term is either typeset in boldface (Description) or separated by a “Tab”\(^6\) (List) from the rest of the paragraph. If you want to have more than one word in the definition, then separate the words with Protected Spaces.

**Exercise:** Typeset the list in example_raw.lyx

You can nest lists within each other in all sorts of interesting ways. An obvious example would be writing outlines. Numbered and bulleted lists will have different numbering and bulleting schemes for sublists. See the User’s Guide for details on the different sorts of lists and for examples of nestings.

### 2.2.3 Other environments: Verses, Quotations, and more

There are two environments for setting quotations apart from surrounding text: Quote for short quotes and Quotation for longer ones. Computer code (the LyX-Code environment\(^7\)) is written in a typewriter font; this environment is the only place in LyX where you are allowed to use multiple spaces to allow code indenting. You can even write poetry using the Verse style, using Return to separate stanzas, and Ctrl+Return to separate lines within a stanza. See the User’s Guide for more complete descriptions of all of the available LyX environments.

**Exercise:** Correctly typeset the Quote, LyX-Code, and Verse in example_raw.lyx

---

\(^5\)LyX will not let you select the first bullet (or the actual number in a numbered section title) unless you also select the paragraph before it, which you probably do not want to do. This is on purpose because the bullet or number depends on the document settings or text position, respectively.

\(^6\)But a typesetter’s tab, which will change to fit the size of the largest term, not a pathetic, rigid, unchangeable typewriter Tab.

\(^7\)used in this Tutorial for the long typing examples
Chapter 3

Writing Documents

The previous chapter hopefully allowed you to get used to writing in LyX. It introduced you to the basic editing operations in LyX, as well as the powerful method of writing with environments. Most people who use LyX, though, will want to write documents: papers, articles, books, manuals, or letters. This chapter is meant to take you from simply writing text with LyX to writing a complete document. It will introduce you to text classes, which allow you to write different sorts of documents. It will then describe many of the additions that turn text into a document, such as titles, footnotes, cross references, bibliographies, and tables of contents.

3.1 Document Classes

Different sorts of documents should be typeset differently. For example, books are generally printed double-sided, while articles are single-sided. In addition, many documents contain special environments: letters contain some environments — such as the sender’s address and the signature — which do not make sense in a book or article. The LyX document class\(^1\) takes care of these large scale differences between different sorts of documents. This Tutorial, for example, was written in the Book document class. Document classes are another major part of the WYSIWYM philosophy; they tell LyX how to typeset the document, so you do not need to know how.

\(^1\)for \LaTeX{} users: this is equivalent to the \LaTeX{} document class
Your document is probably being written in the `Article` document class.\footnote{That is usually the default document class} Try changing to other document classes (using the `Document` $\rightarrow$ `Settings` dialog) to see how they are typeset differently. If you change your document to the `Book` document class and look at the `Environment` box, you will see that most of the allowed environments are the same. However, you can now use the `Chapter` environment. If you are ever unsure about which environments you can use in a given document class, just consult the `Environment` box.

Font sizes, one- or two-column printing, and page headings are just some of the ways journals’ typesettings differ from one another. As the Computer Age continues to mature, journals have begun accepting electronic submissions, creating \LaTeX{} “style files” so that authors can submit correctly typeset articles. \textsc{LyX} is set up to support this as well. For example, \textsc{LyX} supports typesetting (and extra environments) for the American Mathematics Society journals using the `Article (AMS)` document class.

Here is a very quick reference to some of the document classes. See the `Special Document Classes` section of the `Additional Features` manual for many more details.

<table>
<thead>
<tr>
<th>Name</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>article</td>
<td>one-sided, no chapters</td>
</tr>
<tr>
<td>article (AMS)</td>
<td>layout &amp; environments for American Math Society</td>
</tr>
<tr>
<td>report</td>
<td>longer than article, two-sided</td>
</tr>
<tr>
<td>book</td>
<td>report + front and back matter</td>
</tr>
<tr>
<td>presentation</td>
<td>transparencies</td>
</tr>
<tr>
<td>letter</td>
<td>lots of extra environments for address, signature...</td>
</tr>
</tbody>
</table>

### 3.2 Templates: Writing a Letter

One way to write a letter would be to open a new file, and choose a `Letter` class in the `Document` $\rightarrow$ `Settings` dialog. While this is the most obvious way to write a letter, it seems like extra work. Every time you write a business letter, you want to have your address, the address to which you are sending it, a body, a signature, etc. \textsc{LyX} therefore has a `template` for letters, which contains a sample letter; once you have a template, you can
just replace a couple of parts of the letter with your text each time you
write a letter.

Open a new file with File $\triangleright$ New from Template. Select letter.lyx as
the template. Save and print the file to see how the various environments
are typeset.

When you look at the Environment box, you will see several environ-
ments, like the My Address environment, that do not exist in most other
document classes. Others, like Description, are familiar. You can play
around for a while to figure out how the various environments work. You
will notice for example that the Signature environment has the word “Sig-
nature:” in red before the actual text of the signature. This word does not
show up in the actual letter, as you will see if you view/export the file. It
is just there to let you know where the signature goes. Also, note that it
does not matter where in the file the Signature line is placed. Remember,
\LaTeX{} is WYSIWYM; you can put the Signature environment anywhere you
want, but \LaTeX{} knows that in the printout, the signature should be at the
end.

A template is just a regular \LaTeX{} file. This means you can fill in your
address and signature and save the file as a new template. From now on,
any time you want to write a letter, you can use the new template to save
time. We do not have to suggest an actual “exercise” here; just write a
letter to someone!\footnote{One warning, if you are writing from a template. If you erase all of the text in an
environment — for example, if you erase the whole My Address field so that you can
replace it with your own — and then you move the cursor without writing any text, the
environment may disappear. This is because most environments cannot exist without
any text in them. Just reselect the environment from the Environment box to get it back.}

Templates can be a huge time-saver, and we urge you to use them
whenever possible. In addition, they can help a person learn how to use
some of the fancier document classes. Finally, they may be useful for a
person who is configuring \LaTeX{} for a bunch of less computer-aware users.
When they are first learning \LaTeX{}, it will be less intimidating if they have a
letter template customized for their company, for example.
CHAPTER 3. WRITING DOCUMENTS

3.3 Document Titles

LyX (like LaTeX) considers the title — which may contain the actual title, the author, the date, and even an abstract of a paper — to be a separate part of the document.

Go back to your first LyX document and make sure it is using the Article document class. Type a title on the first line, and change the line to the Title environment. On the next line, type your name and change it to the Author environment. On the next line, write the date in the Date environment. Type a paragraph or two summarizing your document using the Abstract environment. Notice how the title is presented when it is printed out. If you change the document format to Book, you will get a separate title page, like the first page of this tutorial.

Exercise: Fix the title, date, and author in example_raw.lyx

3.4 Labels and Cross-References

You can label section headings, list items, formulas, footnotes, and floats in your document. Once you do so, you can refer to the element in other parts of the document, using cross-references. You can refer to a section’s number, to the page on which the section begins or to both. As with section numbering, LyX also takes care of cross-reference numbering for you. Automatic management of labels and cross-references is among the most significant advantages of LyX (and LaTeX) over conventional word processors.

3.4.1 Your first label

Go to our second section, whose title is “About This Document”. Click at the end of the section title line, and select Insert ▹ Label or the toolbar button 🎨. A dialog asks you for a label name, and gives you a suggestion. When you click on OK, the label name will be placed in a box next to the section title.

---

4You should not be using the letter any more, since the Letter document class does not allow titles.
5Floats are explained in the User’s Guide and the Embedded Objects manual.
3.4. LABELS AND CROSS-REFERENCES

So far you have not done anything — the output will look exactly the same, since labels do not show up in the printed document. However, now that you have added a label, you can refer to that label with cross-references. We will do that next.

3.4.2 Your first cross-reference

Place the cursor somewhere in Section 2 of your document. Type

\begin{verbatim}
If you want to know more about this document, then see Section 2.
\end{verbatim}

Now, with the cursor before the final period, select Insert Cross Reference or the toolbar button 🏷️. The Cross-reference dialog pops up. It shows a list of the possible labels you can reference. At the moment, there should be only one, “sec:About-This-Document”. First, select the drop-down menu labeled “Format” and select “<reference>”. Then select “sec:About-This-Document” (it may be selected by default), and a reference marker will appear containing “Ref: sec:About-This-Document” (To be really correct, you should put a Protected Space (shortcut Ctrl+Space) in between the word “Section” and the reference.) An alternative way to reference a label is to right-click the label and select Copy as Reference in the pop-up context menu. The cross-reference to this label is now in the clipboard and can be copied to the actual cursor position via the menu Edit Paste (shortcut Ctrl+V). In the printed document, this reference marker will be replaced with the section number. Preview your document and you will see that LaTeX has been even cleverer than that. It refers to “Section 2”.

Conveniently, a cross-reference acts as a hyperlink when you are editing a document in LyX; clicking on it will pop up the Cross-reference dialog, clicking Go to Label will move the cursor to the referenced label.

3.4.3 More fun with labels

We told you that LyX takes care of numbering cross-references; now you can test this claim. Add a new section before Section 2. Update the preview, and — voilà! — the section cross-reference changed to “3”! Change the section “About this Document” to a subsection, and the cross-reference
will reference Subsection 2.1 instead of Section 3. The page reference will not change unless you add a whole page of text before the label, of course.

If you want some more practice with labels, then try putting a new label where your first cross-reference was, and refer to that label from elsewhere in the document. If you will be inserting cross-references often, it may be convenient to leave the Cross-reference dialog open.

If you want to confirm that the cross-referencing gets the pages right even for larger documents, Copy a couple pages of text from the User’s Guide to the clipboard, and Paste them into your document.\(^6\)

**Exercise:** Fix the references in `example_raw.lyx`

### 3.5 Footnotes and Margin Notes

Footnotes can be added using the toolbar button \[\] or the menu Insert ➤ Footnote. Click at the end of the word “\(\text{LYX}\)” somewhere in your document and insert a footnote. A footnote box appears where you can enter the text of the footnote. \(\text{LYX}\) should place the cursor at the beginning of the footnote box. Type

\(\text{\(\text{LYX}\) is a typesetting word processor.}\)

Now click on the button labeled “foot”. The footnote box is closed, leaving the button showing where the footnote marker will be in the printed text; this is called “folding” the footnote. You can unfold the footnote at any time and re-edit its text by clicking again on the “foot” button.

A footnote can be cut and pasted like normal text. Go ahead; try it! All you need to do is select the footnote button\(^7\) and Cut and Paste it. In addition, you can change regular text to a footnote, by selecting it and hitting the Backspace key when the cursor is in the first position of a footnote, or by hitting the Delete key when the cursor is in the very last position of the footnote.

Margin notes can be added using the menu Insert ➤ Marginal Note or the toolbar button \[\]. Margin notes are like footnotes, except that:

---

\(^6\)By the way, copying a chapter title may cause an error, because chapters are not allowed in the article class, see Section 3.1. If this happens, just delete the chapter title.

\(^7\)It may be easier to select it using the keyboard. You might accidentally open the footnote if you are trying to select the marker itself with the mouse.
3.6. **BIBLIOGRAPHIES**

- the on-screen boxes say “margin” instead of “foot”

- the notes will be placed in the margin, instead of below the text

- margin notes are not numbered

Change your LyX footnote back to text, then select and change it to a margin note. Run \LaTeX{} again to see what the margin note looks like.

**Exercise:** Fix the footnote in example_raw.lyx

### 3.6 Bibliographies

Bibliographies are similar to cross-references. The bibliography contains a list of references at the end of the document, and they can be referenced from within the document. Like section titles, LyX and \LaTeX{} make your job easier by automatically numbering the bibliography items and changing citations when the item numbers change.

Go to the end of the document and switch to the Bibliography environment. Now, each paragraph you type will be a reference. Type “The Lyx Tutorial, by the LyX Documentation Team” as your first reference. Note that LyX automatically puts a number in a box before each reference. Click on the boxed reference number, and the Bibliography item dialog box appears. The Key is to refer to this reference within the LyX document, the Label appears in output. When no Label is set (default), you will see the number of the bibliography in the output. Now change the Key field to “lyxtutorial” to make it easy to remember.

Now pick somewhere in your document that you would like to insert a reference. Do so with Insert\textgreater Citation or the toolbar button \textcircled{C}. A Citation dialog appears. The left panel in this dialog lists all the bibliography entries, and this field allows you to choose which bibliography item you want to cite. Select “lyxtutorial” (right now, that is the only item in the bibliography), then use the Add button in the center to insert it. (You can have multiple citations in the same place by transferring a number of keys this way.)\footnote{If one uses label names for references that are easy to remember it is easier to find the entry in the list of references.} Click the OK button. Now preview your file and you will see that
the citation appears in brackets in the text, referring to the bibliography at
the end of the document.

The Text after field in the Citation dialog will put a remark (such as a
reference to a page or chapter within the referenced book or article) in
the brackets after the reference. If you want the references to have labels in-
stead of numbers in the printed output (for example, some journals would
use “[Smi95]” to refer to a paper written by Smith in 1995), use the Label
field in the Bibliography item dialog. See the User’s Guide for details.

Exercise: Fix the bibliography and citation in example_raw.lyx

3.7 Table of Contents

You may want to put a table of contents at the beginning of your docu-
ment. LYX makes this easy to do. Just hit Return after your document title
and before your first section title and select Insert▷List / TOC▷Table of Con-
tents. The words “Table of Contents” will appear in a button on the first
line of the document.

This may not appear to be very useful. However, if you look at your
preview, you will see that a table of contents has been generated, listing
the various sections and subsections in your document. As usual, if you
reorder sections or create new ones, you will see those changes in the pre-
view when you update it.

The table of contents is not printed in the on-screen version of the doc-
ument. But you can display the table of contents in a separate window by
clicking on the table of contents button, or by using View▷Outline Pane or
the toolbar button ⊹. This menu will work even if you do not have a table
of contents inset in your document. This is a very useful tool for rearrang-
ing your document parts. Clicking on a (sub)section title in the Outline
window will highlight that line and move the display (in the LYX editing
window) to that place in the document. You can also use the arrow keys
to move up and down in the table of contents. You may therefore find it
convenient to leave this window open throughout editing sessions. You
can get similar functionality from the Navigate menu, though, where the
table of contents appears automatically.

To get rid of the Table of Contents, you can delete the table of contents
button just like any other text.
Exercise: Fix the table of contents in example_raw.lyx
Chapter 4
Using Math

\LaTeX is used by many scientists because it outputs great looking equations, avoiding the control characters used by word processors and their equation editors. Many of these scientists are frustrated, however, because writing equations in \LaTeX is more like programming than writing. Happily, \textsc{LyX} has WYSIWYM support for equations. If you are used to \LaTeX, you will find that all of the usual \LaTeX math commands can be typed in normally, but they will show up in a WYSIWYM fashion. If, on the other hand, you have never written in \LaTeX, then the Math Panel will allow you to write professional-looking math quickly and easily.

4.1 Math Mode

Somewhere in your \textsc{LyX} document, type:

\begin{quote}
I like what Einstein said, \textit{E}=mc^2, because it is so simple.
\end{quote}

Now, that equation does not look very good in \textsc{LyX} and in the output; there is no space between the letters and the equals sign, and you would like to write an actual superscript for the “2”. That bad typesetting happened because we did not tell \textsc{LyX} that we were writing a mathematical expression, so it typeset the equation like regular old text.

But we can create a formula that will be typeset properly. Highlight the equation and click the toolbar button $\Sigma$ or use the menu Insert $\triangleright$ Math $\triangleright$
## Inline Formula

If nothing is highlighted LyX inserts a little blue square, which is an empty math formula. The expression appears in blue and the blue square disappears as soon as the formula is not empty. Now type `Esc` to leave the equation. The purple markers disappear, leaving the cursor to the right of the expression. Now, if you type something, it will be regular text.

Looking at the output you will notice that the expression was typeset nicely, with spaces between the letters and the equals sign, and a superscript “2”. Letters in math mode are assumed to be variables, and come out in italics. Numbers are just numbers.

This math editor is another example of the WYSIWYM philosophy. In \LaTeX, you write a mathematical expression using text and commands like `\sqrt`; this can be frustrating, because you cannot see what an expression looks like until you run the file under \LaTeX and you may have to spend time, for example, finding missing brackets. LyX does not attempt to get the expression to look perfect (WYSIWYG), but it gives you an extremely good idea of what the expression will look like. \LaTeX then takes care of the professional typesetting.

### 4.2 Navigating an Equation

Now let us change $E = mc^2$ to $E = 1 + mc^2$. Use the arrow keys to move the cursor into the expression. Note that when you enter the expression, the purple markers appear to let you know you are editing math. Now you can use `Left` and `Right` to move the cursor past the equals sign, and just type “1+”. Again, you can use the arrow keys or `Esc` to leave the formula.

Other than the special keys described below, typing in math mode is like editing regular text. Use `Delete` (or `Backspace`) to delete things. Select text either with the arrow keys or with the mouse. `Edit > Undo` works in math mode as well as cut and paste. One thing to be careful of: if you are left or right outside a formula and you press `Delete` or `Backspace` respectively, you delete the whole formula. Luckily, you can just use `Undo` to get it back.

What if you want to change $E = mc^2$ to $E = mc^{2.5} + 1$? Again, you can use the mouse to click in the right place. However, you can also use the arrow keys. If the cursor is just after the “c” but before the “2”, then press
4.3. EXPONENTS AND INDICES

Up and the cursor is moved to the level of the superscript, just before the “2”. Add the “.5”. Now, hitting Down will move the cursor back to the regular level. If you hit Space instead of Down, the cursor will be placed after the superscript (so that you can then type the “+1”).

4.3 Exponents and Indices

An exponent can be entered from the Math Toolbar (see below), but it is actually simpler just to type the caret key, “^”. LYX will place another blue rectangle in the superscript, so that whatever you write next will be superscripted, and in a smaller font size. Everything you type until you hit a Space (or Esc to exit the formula entirely) will be in the superscript.

Writing a subscript (index) is just as easy; start one by typing the underscore key “_”. You can subscript and superscript both subscripts and superscripts like this: \( A_{a_0+b^2} + C^{a_0+b^2} \).

**Exercise:** Put equation 1 of example_raw.lyx into math mode.

4.4 The Math toolbar

The Math toolbar is a convenient way to enter symbols and/or to perform complicated formula operations. Many of these operations can be accomplished from the keyboard or the Insert>Math or the Edit>Math menus (the latter only appears when you are in Math mode). However, we are going to concentrate on using the Math toolbar, just to let you know what is out there; you can learn keyboard shortcuts and commands later from the Math manual.

The Math toolbar is shown when the cursor is in a formula and can also be turned on manually in the menu View>Toolbars. When you click there on “Math” (그림) the toolbar will be shown permanently at the bottom; this state is visualized in the Toolbars menu with a checkmark. When you click in this state again on “Math” in the Toolbars menu, the Math toolbar is only shown when the cursor is within a formula; this state is visualized by the renaming of the menu entry from “Math” to “Math (auto)”.
4.4.1 Greek and symbols

The Math toolbar allows you to choose from a large array of symbols used in math: operators, arrows, relationships, delimiters, special characters, sums and integrals. Note that subscripting and superscripting allow you to put lower and upper limits on sums and integrals.

4.4.2 Roots, decorations, and delimiters

To type a square root, just click on the button $\sqrt{\phantom{0}}$. The square root appears, and the cursor is in a new insertion point inside the square root. You can type variables, numbers, other square roots, fractions, whatever you want. LyX will automatically resize the square root to fit what is inside.

Adding a “frame decoration” to a character ($\overrightarrow{a}$) or group of characters ($\overrightarrow{a + b}$) is done similarly. Decorations are available from the toolbar via the button $\widehat{\phantom{0}}$. Click on a decoration, and LyX will insert that decoration with an insertion point under (or over) it. Just type what you want in the insertion point. There are two sets of decorations: those that resize with the text you type, and those that have a fixed size, and are most appropriate for a single letter.

Delimiters such as parentheses, brackets, and braces work similarly, but are a bit more complicated. Hit the delimiter button $\left[\right]$ to pop up the Delimiter dialog. Your current selection of delimiters is displayed in a box. It is a pair of parentheses by default, but you can choose a pair of braces, a brace and a parenthesis, or choose the empty square to have something like “$a = \langle 7 \rangle$” (the empty delimiter is displayed as a broken line in LyX, but will not show up in the output).

If you are lazy, you can type actual parentheses in math mode, rather than using the Delimiter dialog. However, those parentheses will be the same size as regular text, which will look bad if you have a big fraction or matrix inside the parentheses. So it is better to use one of the three delimiter buttons that insert them directly, for example $\left\{ \right\}$.

You can also put delimiters or a square root sign or a decoration on already existing formula parts. Select the portion of the formula that you want to adjust, and then click on the button you want from the Math Toolbar. Try using this to change Newton’s second law from scalar to vector form ($f = ma$ to $\vec{f} = m \vec{a}$). Once you have learned about matrices, this
4.4. THE MATH TOOLBAR

is how you will put parentheses or brackets around them.

4.4.3 Fractions

To create a fraction, click on the fraction button \( \frac{}{} \) in the Math Toolbar. \LaTeX\ writes two insertion points in a fraction. As you would expect, you can use arrow keys or the mouse to move around a fraction. Click on the top square and type “1”. Now hit Down and type “2”. You have made a fraction! Of course you can type anything within each of the two boxes: variables with exponents, square roots, other fractions, whatever.

Exercise: Put equation 2 of example_raw.lyx into math mode.

4.4.4 Functions: \( \text{lim}, \log, \sin \) and others

Because letters in math mode are considered to be variables, if you type “\( \sin \)” in math mode, \LaTeX\ thinks you are typing the product of the three variables \( s, i, \) and \( n \). The three letters will be typeset in italics, when what you really wanted was the word “\( \sin \)” typeset in Roman. In addition, \LaTeX\ will not put a space between the word “\( \sin \)” and the “\( x \)” (pressing Space will exit the formula). So how do you get “\( \sin(x) \)” instead of “\( \sin(x) \)”?

Click on the Math Toolbar button \( \exp, \tan \) and then on “\( \sin \)” in the pop-up function list. The word “\( \sin \)” is displayed in \LaTeX\ in black, and set in upright roman type. The whole word is treated as one symbol, so if you type Backspace, it will delete the whole word. Now type “(x)”, which will be written in blue italics, like you expect in a formula. In the output, the expression will be correctly typeset. Try it out.

The function list includes other trigonometric functions and their inverses, hyperbolic functions, logarithms, limits, and quite a few others. These functions can take subscripts and superscripts, important for typing “\( \cos^2 \theta \)” or “\( \lim_{n \to \infty} \)”.

Exercise: Put equation 3 of example_raw.lyx into math mode.

4.4.5 Matrices

Click on the matrix button \( \begin{bmatrix} \end{bmatrix} \) in the Math Toolbar. A pop-up dialog allows you to choose how many rows and columns you want in your matrix.
Choose 2 rows and 3 columns and hit OK. $\LaTeX$ prints 6 insertion points in a $2 \times 3$ matrix. As usual, you can put any sort of formula expression (a square root, another matrix, etc.) in each insertion point. You can also leave some of the insertion points empty if you want.

Tab can be used to move horizontally between the columns of a matrix. Alternatively, you can use the arrow keys to move around - hitting Right at the end of one box will move to the next box, Down will move to the next row, etc.

If you need to change the number of rows and columns, use the menu Edit > Rows & Columns or the math toolbar buttons $\overline{\underline{\text{Insert}}}$, $\overline{\underline{\text{Delete}}}$, $\overline{\underline{\text{Rows}}}$, $\overline{\underline{\text{Columns}}}$.

See the User’s Guide for information on how to change the horizontal alignment of each column, and how to change the vertical position of the whole matrix. Note that if you want to write a table containing text, you should use $\LaTeX$’s wonderful table support, rather than trying to write text in a matrix.

### 4.4.6 Display mode

All of the expressions we have written so far have been on the same line as the text that came before and after them, otherwise known as inline expressions. This is fine for short, simple expressions, but if you want to write larger ones, or if you want your expressions to stand out from the text, you need to write them in display mode. In addition, only displayed expressions can be labeled and numbered (see the User’s Guide), and multi-line equations must be in display mode.

While being in a formula, click on the display button $\text{Display}$ in the Math Toolbar. This centers the formula and adds a blank line before and after it. Now type in an expression and compile your file to see how it looks. The display button is actually a toggle; use it now to change a couple of your expressions to display mode and back.

Display mode has a couple differences from inline mode:

- The default font is larger for a few symbols, like $\sum$ and $\int$
- Subscripts and superscripts for limits and sums (but not integrals) are written under and over rather than next to the symbols
- Text is centered
4.5. **MORE MATH STUFF**

Other than these differences, though, displayed expressions and inline expressions are very similar.

One final note about the way displayed formulas are typeset: be careful about whether you are putting your equation into a new paragraph or not. If your formula is in the middle of a sentence or paragraph, then do not press Return. Doing so will cause the text after the formula to start a new paragraph. That text will be indented or follow a blank line, depending on your document paragraph settings, which is probably not what you want.

**Exercise:** Put the various equations in `example_raw.lyx` into display mode, and see how they are typeset differently.

**Exercise:** Using various tools you have learned in this section, you should be able to write an equation like:

\[
 f(x) = \begin{cases} 
 \log_8 x & x > 0 \\
 0 & x = 0 \\
 \sum_{i=1}^{5} a_i + \sqrt{-\frac{1}{x}} & x < 0 
\end{cases}
\]

4.5 More Math Stuff

Now you are familiar with the basics. \LaTeX{}’s math editor can do a lot more. You can refer to the *Math* manual for tips on how to:

- Label and number expressions.
- Create multi-line equations.
- Change typefaces, e.g. to write bold-face text in an expression.
- Fine-tune font sizes and spacing within an expression. (Do not worry about this until your final draft!)
- Write macros. These are very powerful, because you just define them once at the top of the document, and then you can use them throughout the document.
- Do almost all you can do with math.

---

1After you have done it the hard way, give Insert > Math > Cases Environment a try.
Chapter 5

Miscellaneous

5.1 Other major LyX Features

We have not gone through all the possible commands in LyX, and we are not planning on it. As usual, see the User’s Guide and the Embedded Objects manual for more information. We will just mention a couple more major things LyX can do:

- LyX has WYSIWYM support for tables. Use the Insert Table (toolbar button) to get a table. Click on the table with the right button to get a Table Settings dialog box which allows extensive table editing. By pressing the table toolbar will appear permanently.

- LyX also supports including pictures in any format within documents. (You guessed it: Insert Graphics (toolbar button). Then browse for the figure file, rotate or scale it, etc.) Tables and figures can have captions, and LyX will automatically generate lists of figures and/or tables.

- LyX is heavily configurable. Everything from how the LyX window looks to how the output comes out can be configured in a number of ways. Much configuration is done through Tools Preferences. For more information on this, check out Help Customization.

- LyX is being developed by a team of programmers on five continents. Therefore, LyX has better support for non-English languages (such as Dutch, German, French, Greek, Czech, Turkish, ...) than many
word processors. Even the right-to-left languages Arabic, Farsi, and Hebrew and the Asian languages Chinese Japanese, and Korean are supported. You can write documents in other languages and you can also configure LyX to show its menus and error messages in other languages.

- The LyX menus feature keybindings. This means that you can do File > Open by pressing Alt+F followed by O or by using the binding which is shown next to it in the menu (Ctrl+O by default). Keybindings are also configurable. For information on this, check out Help > Customization.

- LyX can read \LaTeX documents. See section 5.2.2.

- Spell-checking, thesaurus, and word count facilities are available.

- Generation of indexes and nomenclatures/glossaries is supported.

5.2 LyX for \LaTeX Users

If you do not know anything about \LaTeX, you do not have to read this section. Actually, you might want to learn about \LaTeX, and then read this chapter. However, some of those who begin to use LyX will be familiar with \LaTeX. If you are such a person, you may be wondering if LyX can really do everything \LaTeX can do. The short answer is that LyX can do pretty much everything \LaTeX can do in one form or another, and it definitely simplifies most parts of writing a \LaTeX document.

Because this is just a tutorial, we are only going to mention things that new LyX users will most likely be interested in. In the interests of keeping the Tutorial short, we will give only minimal information here. The Additional Features and the Embedded Objects manuals have a great deal of information on differences between LyX and \LaTeX, and how to do various \LaTeX tricks in LyX.

5.2.1 \TeX Mode

Anything that you enter in \TeX mode will be passed straight to \LaTeX, and will be displayed in red on the screen. You can use \TeX commands in
L\LaTeX\ by choosing Insert $\Rightarrow$ \TeX Code (toolbar button $\text{TeX}$). This creates a box where everything within it is passed straight to \LaTeX.

In a math formula, \TeX mode is handled a bit differently. \TeX mode is entered there by typing a backslash. The backslash is not written out, but anything you type afterwards will be in red. You exit \TeX mode by typing Space or some other non-alphabetic character, like a number, underscore, caret or parenthesis. Once you exit \TeX mode, if \LaTeX knows the \TeX command you have typed in, it will convert it to WYSIWYM. So if you type "$\gamma$" in a formula and then press Space, \LaTeX will change the red "gamma" to a blue "$\gamma$". This will work for almost all, non-complicated math macros. This may be faster than using the Math Toolbar, and will be especially convenient for experienced \LaTeX users.

As a special case, if you type "$\{\}$" in a formula, the beginning and ending braces will be inserted in red while the cursor is placed between the braces. This makes it more convenient to type those commands that take an argument.

\LaTeX cannot do absolutely everything that \LaTeX can do. Some fancy functions are not supported at all, while some work but are not WYSIWYM. \TeX mode allows users to get the full flexibility of \LaTeX, while having all the convenient features of \LaTeX, like WYSIWYM math, tables, and editing. \LaTeX could never support every \LaTeX package. However, by typing \usepackage{foo} in the preamble (see Section 5.2.4.2), you can use any package you want — although you will not have WYSIWYM support for that package’s features.

### 5.2.2 Importing \LaTeX Documents — tex2lyx

You can import a \LaTeX file into \LaTeX by using the File $\Rightarrow$ Import $\Rightarrow$ \LaTeX (plain) menu in \LaTeX. This will call the program \texttt{tex2lyx} which will create a file foo.lyx from the file foo.tex. \LaTeX will then open that file. If the translation does not work, you can try calling \texttt{tex2lyx} from the command line, possibly using fancier options.

Even when the translation does work, \texttt{tex2lyx} may not translate everything, though it does handle most legal \LaTeX. It will leave things it does not understand in \TeX mode; so, after translating a file with \texttt{tex2lyx}, you can look for the red text and manually edit it to get it right.

\texttt{tex2lyx} has its own documentation (manpage), which Unix/Linux
users can access via the console command `man tex2lyx`. The manpage describes which LaTeX commands and environments are not supported, what bugs you might run into (and how to get around them), and how to use the various options.

It is important to understand that tex2lyx can only translate files whose document class is “known” to LyX, that is, for which there is a corresponding LyX layout file. If there is no layout file, then you will get an error saying that the conversion could not be performed. So, unless you have a layout for the document class of your LaTeX file, tex2lyx simply will not know how to translate the LaTeX that it finds there into things LyX understands. More about layout files and how they are created is explained in detail in Chapter 5 of the Customization manual.

### 5.2.3 Converting LyX Documents to LaTeX

You might wish to convert a LyX Document to a LaTeX file. For example, a co-worker or co-author who does not have LyX might want to read it. Select File > Export > LaTeX. This will create a file `whatever.tex` from the `whatever.lyx` file you are editing.

### 5.2.4 LaTeX Preamble

#### 5.2.4.1 Document Class

The Document > Settings dialog takes care of the document-wide options, such as changing the document class, default font size and paper size. Document class options and also options for LaTeX packages can be entered there in the Class options area.

#### 5.2.4.2 Other Preamble Matter

If you have special commands to put in the preamble of a LaTeX file, you can use them in a LyX document as well. Select Document > Settings > LaTeX Preamble and type in the dialog window (or from the document settings dialog, depending on the frontend). Anything you type will (as with TEX mode) be sent directly to LaTeX.
5.2.5 BibT\TeX

L\下面是小支持BibT\TeX，它允许您建立文献参考数据库，用于多个文档中使用。选择Insert\textendash List/TOC\textendash BibTeX Bibliography以包括一个BibT\TeX文件。在Database字段中加载BibT\TeX文件，在Style字段中加载BibT\TeX风格文件。

After you have done this, you can use citations from any bibliographies you have included with Insert\textendash Citation (see Section 3.6). The box in the Citation dialog will show a list of all the references in your BibT\TeX file.

5.3 Errors!

Sometimes when you try to view a document, there will be errors, things that L\textit{\textsc{y}}X or L\textit{\textsc{a}}\TeX cannot understand. When this happens, L\textit{\textsc{y}}X will open a L\textit{\textsc{a}}\TeX Errors dialog. Clicking on individual errors in this dialog will take you to the place in the L\textit{\textsc{y}}X document where the error occurs and also display the detailed L\textit{\textsc{a}}\TeX error message.